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Form Finisher quick reference card 
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Marking text 
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Marking fields 
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Dialog box keys 
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Use the arrow keys to move the cursor one character (or line) 
in the direction of the arrow on the key. Also use them to move 
from menu to menu, and from item to item within menus. 
In Fill in mode, the up and down arrow keys move the cursor 
from field to field. 

Use the TAB and SHIFT-TAB keys to move the cursor to the next 
and previous fields, respectively. 

Hold down the SHIFT key and press the LEFT or RIGHT 
arrow keys to mark text. 

Hold down the SHIFT key and press the END key to mark 
text from the cursor position to the end of the field. 

Hold down the SHIFT key and press the HOME key to mark 
text from the cursor position to the beginning of the field. 

Hold down the SHIFT key and press RETURN to mark fields. 

Use the arrow and tab keys to move from option to option 
in dialog boxes. 

Press the SPACEBAR to press buttons within dialog boxes. 

Press RETURN to select OK and save all selected options. 
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DISCLAIMER: Power Up extends no actual or implied endorsements of the programs it distributes and 
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and Power Up does not warrant or represent their suitability for such purposes. Power Up is not engaged in 
the practice of law. nor does it render legal. accounting, medical, or other specialized professional services. 
Programs offered by Power Up should not be relied upon as substitutes for professional services, and pur- 
chasers should conduct independent research to determine whether specialized programs adequately 
address problems involving legal. accounting, financial, medial. andlor other specialized services. 

SOFTWARE LICENSE AGREEMENT: BY USING THE ENCLOSED COPY OF THIS FORM FINISHER 
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UNDER THEIR SPECIFIC RETURN POLICY. 
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Power Up Software Corporation (Power Up) remains the sole owner of this program. Power Up grants to 
you, and you accept, a non-exclusive license for the use of this program. 

The program and its documentation are copyrighted. You rnay not remove or conceal any trademark or 
copyright notice appearing on any copy of the program or documentation. 

You may use this program on only one computer at a time. You may not make any copies other than a 
backup copy for your personal use. You may not rent, lease, lend, or otherwise distribute copies of the 
program or documentation to others. You may not transfer this program electronically from one computer to 
another over a network. 

You may not decornpile. translate, reverse engineer, or disassemble this program, nor may you create 
derivative works from it 
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Introduction 

We designed Form Finisher to make it easy to fill out preprinted 
forms. You can use it with all types of forms-time sheets, in- 
voices, purchase orders, express courier forms, packing lists- 
any form you’ve been filling out with a typewriter or by hand. 

Form Finisher uses a simple, three step process. First you 
describe your form, which means telling Form Finisher what 
items are to be filled in (name, address, etc.) and where they are 
located on the form. The form description process is simple and 
straightforward, and you only have to do it once for each type of 
form, since Form Finisher stores your description and uses it 
again whenever needed. 

The second step is to provide the actual data that will print on 
the form. Fill in the form as many times as you want, with each 
form saved on disk as a distinct record. Look up old records, 
update them, or copy all or parts of the record into new records 
as needed. No more correction fluid-edit your work on the 
screen, then print it on the form when you’ve got it right. 

The final step is the payoff-insert a blank form in the printer, 
and watch Form Finisher fill it out. Your form will have a neat, 
professional look every time. Forget about fiddling with a 
typewriter carriage to move printing up or down half a line. 
Form Finisher takes care of half-line spacing for you. Forget 
about lining up numbers in columns and spacing over to start 
typing at the right place. Let Form Finisher do it! 

Form Finisher provides many additional features that make 
filling out forms even faster and easier. For example, Form 
Finisher can access information in other database files such as 
standard dBASE IV files, DeskMate Address Book or DeskMate 
Filer files, and then can automatically insert the retrieved data 
into your form. To save you from tedious calculations, Form 
Finisher will do simple calculations for you. 
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We think you will find Form Finisher easy to learn, fun to use, 
and most importantly, a great time and effort saver. We‘re 
proud of the result, but we know that there are always ways to 
improve a product. We‘d like to hear your suggestions: 

Form Finisher Design Team 
Power Up Software Corporation 
P.O. Box 7600 
San Mateo, CA 94403 

How do you start? 

If you have not yet installed the Form Finisher program on your 
computer, see “Installation” in the Appendix. 

If you’ve never used a DeskMate program, scan ”Using a 
mouse” in the Appendix. That section also explains some of the 
terms we use. 

Work through the Tutorial in Chapter 2 to learn how to enter 
data into a predefined form, and how to create a new form. For 
more details on individual tasks, refer to the index and to later 
chapters of this manual. 

Form Finisher runs under DeskMate. If you have a recent 
version of DeskMate (1988 version 03.02 or 1989 version 03.03), 
follow the instructions for the “Standard DeskMate version” 
below. If not, follow the ”Runtime DeskMate version” instruc- 
tions. The Runtime DeskMate version provides you with 
enough of DeskMate’s features to use Form Finisher, but doesn’t 
include some handy DeskMate applications such as the Address 
Book and the Filer. 

Standard DeskMate Hard Disk Users 
version Use the EJ and arrow keys or mouse to move your cursor into 

the window titled FORMFINISH and press m. 
Floppy Disk Users 
Use the Q and arrow keys or mouse to move your cursor into 
the PROGRAMS window and highlight FF . PDM in the list. 
Press [tll. 

Or, Select Run from the File menu m) and press a. Type FF 
and press El when the Run File dialog box prompts for the 
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program name. When DeskMate says that it can't find FF, insert 
the Form Finisher Program disk and press El. 

Runtime DeskMate Hard Disk Users 
version Change to the directory that contains the Form Finisher pro- 

gram. Type FF and press El. DeskMate will load and then run 
Form Finisher. 

Floppy Disk Users 

On 3.5" floppy disk systems, insert the Form Finisher disk in 
drive A. On 5.25" floppy disk systems, insert your working copy 
of the Form Finisher Program disk in drive A. Insert the Run- 
time disk in your second drive if you have one. Otherwise, 
DeskMate will prompt you for files as it needs them. When that 
happens, eject the program disk and insert the Runtime disk 
until DeskMate asks for the program disk again. 

Type FF and press El. DeskMate will load and then run Form 
Finisher. If it prompts for a file while loading the program, 
insert the disk containing the file and press GI. 

Quit the program To exit Form Finisher to the Desktop (or DOS if you are using 
the Runtime version), choose Exit from the File menu or press 
[bcj one time. 

Ibcl is the global command to exit any command in progress. 
When there is no command in progress, pressing [Escl takes you 
out of Form Finisher. 

If you have made changes to your document since it was last 
saved, a dialog box will ask you if you want to save the changes 
before exiting. Select Y e s  or press El to save the changes and 
exit Form Finisher. 

Note to floppy disk users When you exit Form Finisher, your computer looks for a file 
named COMMAND.COM. If the file can't be found, a message 
prompts you to insert a disk containing this file. Insert the disk 
you started your computer with. 

~ ~~ ~~ 
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Some typographical conventions 

This manual uses the following typographic conventions: 

lril 
El The Tab key 
m The Shift key 
C h r i s  YU 

The Enter or Return key 

Anything that you type in is shown in this typeface 

Product support 

If you can't find the answer to a question in this manual, our 
Product Support Department can help you. Have your computer 
turned on and this information handy before you call: 

your name and address 
the product name and version number 
your computer make and model, the amount of RAM in- 
stalled, the type and capacity of the hard disk and floppy 
drives, the display adapter and monitor type, printer name 
and model number, and list of peripherals attached 
DOS version number 
contents of your CONFIG.SYS and AUTOEXEC.BAT files 

Call Product Support with a clear description of your problem at 
(415) 345-0551. In the United Kingdom, calO252-879644. 
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2 

Tu to ria I 

This tutorial familiarizes you with the basics of Form Finisher. 
You will first learn how to fill in form data using a United States 
Postal Service Express Mail form, one of three form ”descrip- 
tions” provided with the program. The other form descriptions 
included with the program are Airborne Express and Federal 
Express. (See “Fill in form data” on the next page for more 
information.) Then you’ll learn how to print data onto the form. 
(If you don’t have an Express Mail form, you can still go 
through this section to learn how to enter data and print onto 
forms you create. For now, just print your data on a blank sheet 
of paper.) 

We’ll show you one or sometimes two ways to perform a 
particular task. Some of you are using a mouse and some a 
keyboard, and very often there are several ways to accomplish 
the same task. Many commands have a designated accelerator 
key. Use accelerator keys to quickly activate frequently used 
commands instead of selecting the command from the menu. 
The accelerator key combination is listed to the right of the 
command in the menu. Refer to that chapter to learn all of the 
ways you can use your keyboard and mouse to quickly create 
and fill in forms. 

Before starting this tutorial, make sure that Form Finisher is 
correctly installed on your computer. (The appendix provides 
installation instructions.) Next, start the program as explained at 
the end of Chapter 1. 

The two working modes 

Form Finisher has two working modes: Describe and Fill in. 
When you first open a form, you will be in the ”Describe” mode, 
which allows you to enter field locations. To enter data into the 
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fields, change to “Fill in” mode by selecting Fill i n  from the 
Form menu. See “Choose Fill in mode,” page 8. 

Open the form 
description 

Figure 2-1 
Tractor-fed Express 

Mail form 

No matter which mode you work in, the menu commands at the 
top of the screen are the same. When a command doesn’t work 
in a particular mode, the command will appear light gray 
(dimmed) in the menu and cannot be selected. 

Fill in form data 

As we mentioned above, Form Finisher includes descriptions of 
three frequently used forms: Airborne Express, United States 
Postal Service Express Mail, and Federal Express. We’ve already 
described each form to Form Finisher by telling it where each 
field on the form is located. A field is anywhere you will input 
data. 

Each time you fill in a form, the program saves your data in a 
separate record in the form file. This keeps the form description 
itself “clean” of any data, allowing you to use the same form 
description over and over. The records are numbered according 
to the order they are created. As you will later learn, you can use 
the Search commands in the Records menu to find specific 
records within a file. 

For this tutorial we are using the tractor-fed Express Mail form 
shown in Figure 2-1. Even if you don’t have this form, you can 
still following the instructions in this tutorial. 

All you have to do is open the form and fill in the correct name, 
address, account information, etc., and then print the form. 

1. Press El to view the commands on the File menu. 
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Figure 2-2 
Selecting a menu command 

Expi 
Figure 2-3 

.ess Mail form 
description 

2. Type the letter lo] or press [o twice to select the Open. . . 
command. The command is highlighted (shown in reverse 
video) when selected. See Figure 2-2. Press ltll to activate the 
command. 

3. The Open File dialog box displays a list of files that you can 
open. Press the 1(1 one time. The first name on the list 
becomes highlighted. Continue pressing the El until 
EXPRESS .FFD is highlighted. Press Icl]. 

The description of the Express Mail form is shown below. 

F o r m  F i n i s h e r  U s e r ' s  G u i d e  7 



Note The filename is followed by a three-letter extension, .FFD. This 
extension is automatically added to the filename by Form 
Finisher when you type the filename in the O p e n  F i l e  : box. 
(See Chapter 4 for information.) 

Additional Hints If you are using a mouse, click on the arrows in the dialog box to 
move through the file list. Click once to move down one file, 
click and hold to scroll quickly through the list. 

If the file you want is not in the list, it could be on another disk 
drive in another directory. Available drives are listed at the end 
of the files list. To change the drive, select it from the list and 
press El. A new file list displays the files available on the new 
drive. 

If you know the exact name of the file you want to open, type 
the first letter of the filename. Or, press the [tl once to move the 
cursor into the O p e n  F i l e  : box and type the filename. Using a 
mouse, click the pointer in the box. 

Choose Fill in mode When you first open the Express Mail form, it will be in "De- 
scribe" mode. To enter information into the fields, you must 
change to "Fill in" mode. 

1. Press [F61 to display the Form menu. 

2. Type the letter IF1 (or press El twice) and press El. The 
word "New" appears in the lower left comer of the screen to 
show that you're working on a new record for the form. 

Fill in the form The first field on the form, C o r p A c c t  is highlighted. This is the 
first field in which you'll enter data. 

1. Type ~ 1 2 3 - 4 5 6  and pressEl or El. The next field to enter 
data, F, is highlighted. 

If you make a mistake while still in the field, press l-1 to 
delete the incorrect text and then retype it. 

To change a field after you press ElI hold the Lct) key and 
press El to move back to the previous field. 

2. The F field is for your Federal Agency Account No. For this 
example, let's assume you do not have such a number. 
Simply press GI (or El) to skip this field. The next field, 
From-Name, is highlighted, and F remains blank. 

3. Type the following information into the "From" fields and 
press El: 

c63 is the Shift key 

~~~~ ~ 
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From-Name Harrison Schreppel 
From Address-Line-1 XYZ Corporation 
FromAddress-Line-2 - 123 Main Street 
F rom-C i t y 
From-State CA 
From-ZIP 12345 

TO Name field is highlighted. Enter the following information 
into the “To” fields and press El. 

To-Name Sylvia Snow 
To-Addres s-Line-1 ABC Corporation 
To-Address-Line-2 987 E. State Street 
To-City Happytown, 
To-S t a t e 
To-ZIP 98765 

Anytown, 

4. Enter information into the Phone field and press The 

CA 

Your form should now look like the following: 

Figure 2-4 
Filled-in Express Mail form 

Additional Hints If you want to print a comma after the city, you must type the 
comma in the City field. (It does not exist in the form 
description.) 

Notice that you cannot read the State field names on the 
screen. In fact, many field names are longer than you can see 
when you look at the form this way. Move your cursor to the 
field and type IH1 ID1 IF1 to display the field definition and see 
the complete field name. See “Display field definition,” page 38 
for more information. 
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Save the record 

1. Press [Rj to display the Records menu. 

2. Press Is] to select the Save command and press El. 

Form Finisher saves the record and assigns it a record num- 
ber. Until now, Form Finisher has called the record "New" in 
the lower left corner of the screen. 

Print the form 

Set up the printer If you are a DeskMate user, you've probably already run Desk- 
Mate's Setup program to tell it what kind of printer you will use. 
If not, see the instructions provided in the Appendix. 

If you use an Epson dot matrix printer, or one that emulates 
(works like) an Epson, perform the following steps: 

1. Press IF61 and type lo]. Press 

2. Press El and type Is]. Press ltll to display the Set Scaling 

3. Move the flashing underline (the cursor) to the Epson 

to return to Describe form 
mode. 

dialog box. 

compatible button and press [spacobsl to select it. Press El or 
click OK to save the change. 

4. Select Fill i n  from the Form menu to print the record. 

If you have a tractor-fed Express Mail form like the one shown 
earlier in Figure 2-1, page 6, insert it in the printer now. 

If you don't have this form, you can get it from your Post Office. 
For now, just print on blank paper. Pay close attention to where 
you position the form in the printer. We've left space above the 
fields on the form description, so don't line up your form where 
the data starts printing, but rather at the actual top of the 
Express Mail form. 

Use the following steps to print the EXPRESS form record you 
created. If the text is not centered properly in the fields after this 
first print, don't panic! We'll show you how to make adjust- 
ments so that your form description matches your printer. 

I 

Print record 

1. Press IF2j to display the File menu. 
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2. PressIpI three times to select P r i n t  r eco rd .  Press m. 
Note The File menu contains several commands that begin with the 

letter P. When you press Ipl the first time, you highlight the 
first command in the list beginning with the letter P. The 
second time you press El, the second command, and so on. 

3. Press [ell again when Form Finisher reminds you to put the 
form in the printer and the form prints. How did it do? 

Make printer offset 
adjustments 

If the Express Mail form data printed slightly above or slightly 
below where it should have been on the form, adjust the form in 
the printer. This is the quickest way to fix the spacing if your 
description is only off by a little. Take special note of where you 
placed the form so that you can position future forms exactly the 
same. If you can't adjust the printout this way, adjust the form 
description using the instructions below. 

Not all printers have the same print starting positions, and few 
printers can print on the extreme top and sides of the page; they 
begin printing slightly lower and to the right of the top left 
corner of the page. The amounts down and to the right are the 
printer ofiets. See Figure 2-5. 

Figure 2-5 
Printer Offsets 

Top leff corner 
Vertical offset 

(Columndlnches Down) 

Horizontal offset 
(RowsAnches Right) 

> - 

- 
This i s  where t h e  t e x t  p r i n t s  
on t h e  page. Notice t h a t  it 
s t a r t s  s l i g h t l y  down and t o  
t h e  r i g h t  of t h e  upper l e f t  
corner of t h e  page. 
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To find out exactly where your printer starts printing, use the 
following steps: 

++++ ++++1++++ ++++2++++ ++++3++++ ++++4++++ ++++5++++ ++++6++++ ++++7++++ 
++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ 
++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ 
++++ ++++-++++ ++++-++++ +>++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ 
++++ ++++-++++ ++++-++++ ++++-++*+ ++++-++++ ++++-++++ ++++-++++ ++++-++++ 
++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ 
++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ 
++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++++ ++++-++-+ ++++-++++ 
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Figure 2-6 
Grid 

1. Place your form in the printer. 

2. Choose P r i n t  g r i d  from the File menu. 

A grid is printed onto your form. See Figure 2-6. The grid 
contains a mark for every printable space on the form. We 
have provided rulers to make measuring easier for you. On 
the horizontal gridlines, the ”1” represents 10 columns, the 
“2” 20 columns, and so on. The top left mark is the printer‘s 
starting position. 

++++ ++++ 
++++ ++++ 
++++ ++++ 
++++ ++++ 
++++ 
++++ 
++++ 
++++ 
++++ 
++++ 
++++ 
++++ 
++++ ++++ 
++++ 
++++ 
++++ ++++ 
++++ 
++++ 
++++ 
++++ 

Now tell Form Finisher the exact starting location for your 
printer. 

1. Choose Describe from the Form menu. 

2. Choose Sca l ing  from the Settings menu. The Set Scaling 
dialog box appears. 

3. Change the ruler scale from rows and columns to inches. 
Move the cursor to the Inches button and press ISEZEI. 

4. Measure the distance from the left edge of the page to the first 
mark of the grid. Enter this distance in Inches r i g h t .  

5. Measure the distance from the top of the form to the top of 
the grid. Enter this distance in Inches down. Select OK to 
use the new settings. 

Choose P r i n t  range from the Files menu to print the form 
using the new printer adjustments. Since there is only one re- 
cord, the default range will be 1, so press El to print the record. 
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Describe a form 

Now that you know how to enter data and print your form, let’s 
go back and see what we did to describe the field locations to 
Form Finisher. Choose N e w  from the Files menu. Form Finisher 
automatically selects the ”Describe” mode. 

Enter form size Choose ~ o r m  s i z e  from the Settings menu. Press El once to 
leave 8.0 as the form width. The width of the form is measured 
starting from where the printer starts printing on the page, not 
from the edge of the form. Type 4 . 2 5  in Form height .  Press 
El to save the new form size. 

Set scaling Choose Sca l ing .  . . from the Settings menu. Select 12 charac- 
ters per inch and 8 lines per inch. Make sure the ruler scales are 
set to rows and columns. Select OK to save the changes. 

Note If your printer doesn’t print 12 cpi and 8 lpi, enter these settings 
anyway. After the form is described, rescale to 10 cpi and 6 lpi. 

Enter field locations First, measure the form. If you’ve not already done so, print a 
grid as described on page 11. We are going to use the marks on 
the grid to tell Form Finisher where each field starts and ends. 
Use the following steps to tell Form Finisher where the first 
field, “Express Mail Corporate Account No.,” is located. 

1. Press IHI to display the Fields menu. 

2. Press El to select the A d d  command and press a. The Field 
Definition dialog box is displayed. 

3. Enter the field name CorpAcct in the first box. Press 
move to the next option, Input  order .  

4. We do not need to change the values for the Input  order ,  
F i e l d  type,  and Alignment options, so press 
cursor appears in the Cols Right  box. 

number of rows to the Corporate Account Number field. In 
ROWS Down on the screen, enter 15 (the number of rows from 
the top of the page that this field should begin printing). 

6. Starting from the left-most mark in the twelfth row on your 
grid, count over the number of columns (characters) to where 
you want data to begin printing. We want to center text in 
this field, so enter 24 in C o l s  Right. See Figure 2-7. 

to 

until the 

5. Starting from the top mark on your grid, count down the 
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Figure 2-7 
Describing the first field 

F i e l d  lime Input  order. 

Field type. Ll T e x t  or number 

0 R i y h l  

7. Press El twice to position the cursor in the Width box. This 
field happens to be 10 characters wide, so press El to leave 
the default width (10) in this field. The width of a field is the 
number of characters that will be filled in the field. 

8. We don't need a calculation in this field, so press El to save 
your changes. The field you described appears on the screen 
in the correct location. 

9. The next field to enter is "Federal Agency Account.'' Figure 2- 
8 shows the field name (Fed-Agency-Account) and location 
values for that field. Repeat steps 1 through 10, entering the 
correct values in the Field Definition dialog box. Describe the 
"From" and "To" fields in the same manner. 
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Figure 2-8 
Express Mail field 
names and values 

Additional Hints 

Run a test print 

Adjust existing field 
definitions 

You cannot create a field that extends to more than one line. You 
must create a second field for the second line of text. 

To see if you entered the field locations correctly, run a test print 
of your new form. 

1. Put a copy of your preprinted form in the printer (or a blank 
sheet if you don’t have a form). Line up @e form in the prin- 
ter exactly as you did when you printed the grid. 

2. PressIml. 

3. Choose Print test form and press El. 
Form Finisher prints the new form description with x’s in the 
entire length of each field. Confirm that your fields are loca- 
ted correctly. If not, go back and adjust the form description. 

To adjust the location or characteristics of a field, use the arrow 
keys to move your cursor to the field you want to change. Then 
press Irl. (You can also doubleclick on the field using the 
mouse.) The field’s description is displayed and you can make 
changes as necessary. 

~ ~~~ 
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3 

Describing a form 

This chapter explains how to create and edit form descriptions to 
match your own preprinted forms. 

Create a new form 

Choose New from the Files menu to open a new form in Describe 
mode. Once you save and name your form, the new name 
replaces "(Untitled)" on the top line. A dialog box prompts you 
to save unsaved changes, if any. Information about saving your 
form is provided in Chapter 4. 

Measure the form 

The first step in creating a new form is to describe to Form 
Finisher exactly where each data field is located. A fierd is 
anywhere that Form Finisher will print data. A field's beginning 
location is where the first character gets printed. The ending 
location is where the last character gets printed when you have 
entered the maximum number of characters for the field. 

There are three ways to measure your preprinted form: 

Print a grid onto a copy of your form. 
Locate fields using a special Word Guide that is sold separately 

Use a ruler. 
by Power Up! 

Although any of these methods will work, the easiest method is 
to print a grid onto your preprinted form so that you can see 
exactly where each field is located. The grid prints according to 
the form size and scaling settings. The default values for these 
settings are as follows: 
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Default Page SCALING 
Layout Settings 

Character width: 
Line spacing: 
Custom settings: 
Ruler scales: 

Printer adjustments: 
Dot matrix printer: 

FORM SIZE 

Form width: 

Form length: 

10 characters per inch 
6 lines per inch 
None 
Rows/columns (the rulers show lines 
down and characters across rather than 
showing both scales in inches) 
None 
Proprinter compatible 

8” (most standard carriage printers 
print 8” wide, leaving a 1 /4” margin on 
each side of the page) 
11” 

Note If you are just coming from the tutorial, the page layout settings 
are set to the Express Mail form’s values. To see the default 
settings, exit Form Finisher, then restart the program. 

To change the scaling settings, see ”Select Scaling” later in this 
chapter. You must select your form size before printing a grid, 
described next. 

Select form size 

Choose Form s i z e  from the Settings menu. Use the O/El 
and lS!SEl keys to delete the current values and enter the width 
and height of your form. Select OK to save the new form size. 

Print a grid 

Use the following steps to print a grid on your form. 

1. Put a copy of the preprinted form in the printer. 

Make a note of where you put the form so that each time you 
put the form in the printer it is positioned exactly the same. 
This helps to minimize spacing problems caused by improper 
form alignment. This is more important when working with 
tightly- or oddly-spaced forms. 

your printer is ready. 
2. Choose P r i n t  g r id  from the Files menu. Select OK when 
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After printing the grid onto your preprinted form, you can see 
clearly where each field starts and ends. Measure the fields in 
either inches or rows and columns, starting from the top left 
edge of the form. Now that you have seen what the grid looks 
like, you can change the ruler scale, font size, and line spacing as 
required. 

Locate fields using the Word Guide 

Optionally available from Power Up is the Word Guide, a trans- 
parent grid containing printed horizontal and vertical rulers that 
you lay over the preprinted form. There are separate Word 
Guide’s to accommodate 10 cpi and 12 cpi forms. 

You can use a Word Guide to read how many rows and columns 
(or inches) from the top of the form a given field starts and ends. 
Measure all of the fields, write down their locations specified in 
horizontal and vertical positions, then enter the information 
quickly using List View (explained in “Define fields using List 
View,” page 28). 

When you use the Word Guide, you must specify the printer 
adjustment values. This was explained in Chapter 2, and is 
further explained in ”Printer adjustments” later in this Chapter. 

Locate fields using a ruler 

As with using the Word Guide, you must compensate for the 
printer’s offset when you use a ruler to measure fields. This was 
explained in Chapter 2, and is further explained in ”Printer 
adjustments” later in this Chapter. Set the ruler scale to inches 
and specify your adjustment values in inches. 

Measure a field‘s starting location as the distance from the upper 
left comer of the form. Measuring your fields within 1/8ths of 
an inch should provide you with an accurate enough measure- 
ment. “Revise the form” on page 30 explains how to fine tune an 
existing field’s location. 
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Select Scaling 

To help you position your data so that it prints properly on the 
preprinted form, Form Finisher provides a number of spacing 
options. These include: 

Printed character width: 10 and 12 characters per inch (cpi), 
condensed, or custom 
Printed line spacing: 6 or 8 lines per inch (lpi) or custom 
Printer adjustments: right and down 
Screen ruler scale: rows and columns or inches 
Dot matrix printer: Epson or Proprinter compatible 

Figure 3-1 shows an example of printed text using the different 
character and line sizes. 

Figure 3-1 This is 10 characters per inch* 
This is 12 characters per inch Type sizes and spacing 

This is 17 characters per inch 

8 ines 
8 I jnes 
HE 

This is 6 lines per inch. 
This is 6 lines per inch. 
This is 6 lines per inch. 
This is 6 lines per inch. 
This is 6 lines per inch. 
This is 6 lines per inch. 

* Characters will be larger than they appear in this figure. 

To select one of the scaling options, choose Scaling from the 
Settings menu. The Set Scaling dialog box appears. 
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Figure 3-2 
Set Scaling dialog box 

Printed  charac ter  width 

8 12 char L per inch 

Q Coidensed 

Printed l i n e  spaciny 

61 h Iincx per  inch 
u U I incs pcr inch 

-~ ~ . . 

c_7 iUstLlr1 sc ttlhlys 

Screen ruler s c a l e s  

Q IllCIlCS 

Pr intcr ad Justmcnts 

1 B Proprinter compatible 

~~~~ 

Click on a setting button to choose it, or press EZl and the arrow 
keys to move your cursor to the button and press the 1-1. 
The button appears shaded when selected. Once you’ve chosen 
your settings, select OK or press El. If you don’t want to use the 
settings, select Cancel or press El. 

If you change a scaling option, print a new test grid on your 
preprinted form so that the scale you see on the form is the same 
as on the screen. If you aren’t sure which scale to use, try 
printing ruled grids with different settings to see which works 
best. The following sections explain how the different settings 
affect your form description. 

Printed character There are four character width options: 10 cpi, 12 cpi, condensed 
width print, and custom. 

10 and 12 cpi 

Typewriters usually type 10 (pica) or 12 (elite) characters per 
inch horizontally. Consequently, most forms are designed for 
typing using a horizontal scale of lOths or 12ths of an inch. Form 
Finisher supports these sizes and displays the appropriate rulers 
for them. For example, if you choose 10 cpi, the horizontal ruler 
is marked off in l/lOths of an inch. 

If you use the rows and columns ruler scale, the ruler won’t 
change when you switch from 10 to 12 cpi but the fields will 
move. That’s because each mark on the ruler stands for one 
character, no matter how wide the character is. A field that is an 
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inch wide will stay an inch wide no matter how you change the 
scale. At 10 cpi, an inch wide field holds 10 characters. At 12 cpi, 
it will hold 12 characters. If the ruler is in columns (characters), 
the field will look larger at 12 cpi than at 10 cpi. 

Condensed 
Many printers provide a condensed (compressed) print mode, 
which is handy if your form requires smaller characters. If your 
printer emulates an IBM Proprinter (most Tandy dot matrix 
printers do) or an Epson dot matrix printer, then Form Finisher 
can switch it to condensed printing. However, because of 
variations among printers, Form Finisher can’t tell how wide the 
characters are. It assumes a width of 17 cpi, which is common, 
but you may have to enter a different value. Your printer manual 
will tell you the correct value, or you can figure it out if neces- 
sary. Bigger numbers mean more characters per inch, which 
means smaller printed letters. 

How do you fell if 17 is the right compressed width for your printer? 
Run a test print (described on page 33) using the default (17) 
character width. Enter a field that extends from almost the left 
edge of the form to the right edge of the form. 

If the text prints at the proper starting point in the field but 
extends too far to the right (the text is too long for the field), 
change to a higher character width, such as 17.1 or 17.5. 
If the text starts at the correct place in the field but does not 
extend far enough to the right in the field (the characters 
appear too small for the field), change to a lower width, such 
as 16.5 or 16.7. 

To change the condensed default width, type the correct value in 
the condensed width box. 

If the text in all of the fields is too far to the left or right, adjust 
the printer offset. See ”Printer Adjustments,” page 23. 

Printed line spacing Standard line spacing on forms and printers is 6 and 8 lpi. Form 
Finisher displays the appropriate rulers for these sizes. 

If neither of the standard lines per inch values is appropriate for 
your form, you may have to use a custom line spacing, ex- 
plained next). If your spacing works for most fields, it might be 
easier to move individual fields half a line down. See “Field 
Definition dialog box,” page 27. 
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Custom You can choose character widths other than 10 or 12 cpi, and 
custom line spacings other than 6 or 8 Ipi, if your printer sup- 
ports the option you choose. When you choose the C u s t o m  
option, Form Finisher understands that you are setting up the 
printer yourself, and won't reset the printer or change its line 
height or character width. To support your custom width, Form 
Finisher automatically resets the rulers to rows and columns. 

To let Form Finisher correctly position your fields if you ever 
switch to another scale, you must specify how many characters 
print per inch horizontally and how many lines print per inch 
vertically. The default values are 10 cpi and 6 lpi, but you want 
to change at least one of these settings. 

Note Form Finisher cannot provide half-line spacing in Custom 
modes and will not print fields that are marked as half-line 
down. 

Screen ruler scales Form Finisher provides two sets of vertical and horizontal ruler 
scales: 

rows and columns 
inches 

The rows and columns ruler shows the vertical scale in rows and 
the horizontal scale in columns. The inches scale shows inches 
on both the vertical and horizontal scales. On both rulers, each 
mark on the horizontal scale represents one character and each 
mark on the vertical scale represents one line. 

If you use a standard character width and line spacing, then 

If you use the Custom option, the ruler scale automatically 
you can choose between the two ruler scale options. 

resets to rows and columns. 

Printer Adjustments In the Tutorial (Chapter 2), we explained that most printers print 
data slightly down and to the right of the upper corner of the 
page. To find the top, left-most point on your printer: 

1. Align the preprinted form in the printer. 

2. Make sure you5 ruler scales, character width, and line spacing 

3. Choose P r i n t  g r id  from the File menu. 

values are set correctly. 
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4. The top left mark on the grid is the top, left-most place the 
printer can reach. Measure the distance from the gridmark to 
the left side of the page. Enter this value in the Inches 
right box (or Columns right in rows and cohnns).. 

5. Measure the distance from the top gridmark to the top of the 
page. Enter this value in Inches down (or Rows down). 

Printer adjustments are illustrated in Chapter 2, page 11. 

Working on more than one printer 

Define the form one way. When you switch printers, tell Form 
Finisher the specific adjustment for the printer you use. 

Moving all fields at once 

You may find that after you’ve entered your fields, they are all 
slightly up or down, or slightly left or right of where you want 
them to be. To make the form print more to the left, enter a 
positive number in Inches right (or Columns right if your 
ruler is in rows and columns). To make the fields print further 
up on the form, increase the number in Inches up (or ROWS 
up). 

View the form 

Them are two ways to view your form on the screen: Form View 
and List View. 

Form View Form View displays horizontal and vertical ruler scales as well 
as any fields for which you have entered locations. The fields are 
drawn with a filled-in box at the start and end of the field. A line 
connects the boxes to show the length of the field. Centered 
inside this field area is as much of the field name as will fit. The 
Form View screen is shown in the Express Mail form figure in 
Chapter 2, page 6. To see the Form View on your screen, choose 
F O ~  view from the Settings menu. 

List View List View displays a list of the fields and their characteristics in 
the input order specified (see ”Input Order” in Chapter 5, page 
26). Figure 2-8 in Chapter 2, page 15, shows an example of the 
List View. To see this view on your screen, choose List view 
from the Settings menu. 

To see how your fields look on the form, choose Form view 
from the Settings menu. You can switch between the two views 
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as often as you need. The following are hints on when to use 
each view: 

When describing the form ... 
If you prefer to measure all the field positions and widths on 
your form in advance and then enter the information all at 
one time, you might find it more natural to enter the field 
information in List View. 
If you have difficulty visualizing how your form will look, 
describe your form in Form View so that you can actually see 
the placement and size of each field as you create it. 
It is often easier to polish the form, for example, move a few 
fields a few characters over, using Form View 
It is much easier to define a sparse form-one with very few 
fields spread over a large pageusing List View. 
If you are describing a form that has a high number of lines 
per inch, or that uses half-line spacing, it will be much easier 
to enter information in List View. (The fields may appear 
overlapping and difficult to read in Form View.) 

When filling in the form ... 
If someone has filled in the form by hand and you are typing 
the information into Form Finisher, you may prefer Form 
View because the screen and the paper form match. 
If you are entering information from a freehand list or from a 
different form, you might find it easier to use List View. 
If you are filling in information on a sparse form, it will be 
quicker to use List View. 
If you are filling in a form that has a high number of lines per 
inch, or that uses half-line spacing, use List View. (The fields 
may appear overlapping on the screen and may be difficult to 
read in Form View.) 
If the order in which you want to enter information is differ- 
ent from the screen layout, or if you have a large form, use 
List View to avoid all the scrolling of the form on the screen. 

Define fields using Form View 

Once you have measured your form using one of the methods 
explained earlier, you can describe the field locations to Form 
Finisher. Because of the spacing variations on preprinted forms, 
we recommend that you enter just a few field locations and then 
use the test print feature (described in Chapter 4) to see where 
the printing comes out on your form. You can then either 
resume entering field location data or make adjustments to the 
scaling options as described in "Select scaling," page 20. 
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When you describe a form using Form View, you can actually 
see the fields you are creating on the screen. Form Finisher 
draws a filled in box at the start and end of the field, and a line 
to connect the boxes to show the length of the field. Centered 
inside this field area is as much of the field name as will fit. 

To describe a form using Form View, use the following 
procedures: 

1. Choose Add from the Fields menu. The Field Definition 
dialog box appears. (We showed you this dialog box in 
Chapter 2 when you were describing the Express Mail form 
fields-see page 14.) 

plained next. 
2. Enter information in the Field Definition dialog box as ex- 

Field Definition dialog box 

It is through this dialog box that you tell Form Finisher what 
your fields look like. Use the following guidelines to define 
fields. 

Field Name Enter the name of the field up to 30 characters. The name must 
be unique, and must begin with a letter, and may contain only 
letters, numbers, and the underline character (no spaces). Form 
Finisher will adjust the name if the one you enter is already in 
use. Form Finisher is upper- and lowercase sensitive, ("NAME" 
is not the same as "name"). Common field names include Name, 
Name-2, Address, Phone-number, Invoice-amount, etc. 

Press Q after you finish entering the name to move to the next 
item in the dialog box. 

Additional Hints If you plan to read the data with a dBASEcompatible program, 
or if you will look up this form's data when working with other 
forms, keep your field names 10 characters long, or if you must 
use longer field names, make sure the first 10 characters are 
unique. dBASE is not case-sensitive ("NAME 
"name" ) . 

the same as 

Input order Enter the order in which you want the field displayed in List 
View when filling out the form. See "Input Order" in Chapter 5 
for information about this command. 
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Field Type Identify the type of information that you will enter into this field 
by selecting one of the following options: 

Text or Number 

You can enter any printable character in this field. 

Dare 

When you begin a new record, Form Finisher enters today’s date 
into this field. Form Finisher does not change the date on old 
records. To modify the date, select the field and type in the new 
date. See “Fill in form data” in Chapter 5. 

Alignment This item allows you to choose whether data entered into the 
field will be left- or right-justified, or centered in the field. 

Cols Right/ 
Inches Right 

Enter the number of columns (or inches) from the left edge of the 
grid or the page that the field begins printing. 

Rows Down/ 
Inches Down 

Half line down 

Enter the number of rows (or inches) down from the top of the 
grid or the page that the field begins printing. 

Choose this option to print the field half a line down. This 
option helps you align fields vertically when your form has 
fields that are not uniformly spaced or contains check boxes. 
(Check boxes are often more closely spaced than other fields, 
and it is almost impossible to perfectly center an ”X” in the box.) 

In Form View, half-line-down fields appear on the same line on 
the screen, but are displayed with a ”+” sign at the beginning 
and ending positions of the field to indicate that they will print 
half a line down. In List View, the “+“ shows after Rows down. 

important Note Half-linedown fields will not print if you select custom spacing. 

Cols Wide/ 
Inches Wide 

Enter the length of the field specified in the ruler units you have 
chosen. For example, if your field is 1/2 inch long, enter .5 in. 

A field cannot extend to more than one line. For example, if your 
form has an area labeled “Comments” that requires three lines 
of space, define this area as three different fields, which might 
be labeled ,‘Comments-1,” “Comments-2,” and “Comments-3.” 

Decimal places This option specifies the degree of accuracy that is used when 
calculating values. If you define a field to one decimal place, but 
a calculation results in a value of 7.56, what is stored there and 
displayed (and used for future calculations) is 7.6. 
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DEFINE CALC The DEFINE CALC option allows you to add, subtract, divide, or 
multiply up to 25 calculations per form and enter the value in 
this field. The calculation can be up to 160 characters in length. 

Boilerplate fields 

A boilerplate field contains text that is the same on every form. 
For example, your company name or account number. To create 
a boilerplate field, enter the data as a constant in the Calcula- 
tions box using the following steps. 

1. S e k d D E F I N E  CALC. 

2. Type a leading quote (9, then type the boilerplate text in the 
Calculations box. 

See Chapter 7 for more information about this and other Calcu- 
lation options. 

After selecting your options, press El or select OK at the bottom 
of the dialog box. The program draws the defined field on the 
screen. 

Save options 

Define fields using List View 

List View shows the fields in a list format. 

To enter a field in List View, choose L i s t  view from the 
Settings menu. Then press I a r a  or choose A d d  from the 
Fields menu. This brings up the Field Definition dialog box we 
just described. After entering the field definition, Form Finisher 
adds your field to the displayed list. 

Edit commands 

The edit commands-ut, copy, paste, dear, and rnme-can be 
used on text fields when describing the form. They can be 
used only on text when filling in form data. You cannot move, 
change, or delete fields while in the "Fill in" mode. 

Mark the text or field you want to edit, and choose the edit 
command using one of the following methods: 

Select the command from the Edit menu. 
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Press the designated accelerator key. 

Mark text 
cio is the Shift key 

To mark text in a field, highlight the field by pressing the El key 
while pressing the El/@ keys. With a mouse, click and drag 
across the text you want to mark. 

Mark fields Move to a field you want to mark, hold down El and press El. 
With a mouse, press IXI and click on the field. 

Note You can mark up to 25 fields at a time. 

Cut Choose Cut (l3Dm) to delete the selection from the form and 
store it on an invisible clipboard to be pasted later into a new 
location. If you accidently cut a selection from your form, paste 
it back using the Pas t e  command. 

Copy Choose copy (@-)to leave the selection in its original 
location and store a copy on the clipboard. 

Clear Choose Clear  (IDellho remove a selection from the form perma- 
nently. Cleared data is not stored on the clipboard. 

If you accidently cleared a field, either retype the field definition 
data or, if you deleted many fields, save the form under a new 
name using the Save a s .  . . command from the File menu (see 
Chapter 4). This leaves your original file unchanged. 

Paste Choose Pas t e  to copy the clipboard selection to a new location. 
Move your cursor to the location, then press Ln_l+EJ. 

Move To move marked text or fields, choose Move. . . (@-) from 
the Edit menu. Enter the direction and the number of rows and 
columns (or inches) you want the selection moved, then select 
OK. Select CANCEL to stop the move command. 

Marked selections are moved relative to their current position. 
For example, if you enter a move value of 3 columns right, the 
selection will move 3 columns to the right of where it was. 

The Move command does not store items on the clipboard. 
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About clipboards ... Form Finisher uses two clipboards. The standard DeskMate clip 
board stores text so that it can be moved to other programs as 
well as within Form Finisher. A separate clipboard stores form 
definitions for use only in Form Finisher, protecting other 
programs against your accidently copying a field definition into 
a file that can’t read that kind of data. 

Only one selection can be stored on each clipboard at a time. The 
current clipboard selection is overwritten when a new selection 
is cut or copied. A selection is considered anything you have 
marked when you choose the cut or copy command. For ex- 
ample, if you copy a field to the clipboard, the next field you 
copy will overwrite the first field. Text stored on the second 
clipboard will remain unaffected. 

Revise the form 

To change a field’s definition, double-click on it, or move the 
cursor to the field and press (tll. The Field Definition dialog box 
appears. Make changes as needed, then select OK to save the 
changes. 

There are several ways to change the location of a field or fields. 

Use the Printer adjustments to adjust where all of the fields 
on the form will print. See ”Printer adjustments,” page 23. 
Use the Edit commands to move one or a small group of 
fields. See “Edit Commands,” page 28. 
Move an individual field by changing its coordinates or by 
moving it half a line down. See ”Field Definition Dialog BOX,” 
page 27. 

Add or delete fields Adding and deleting fields will affect stored records: 

If you add a field, Form Finisher creates a new, empty field in 
all stored records. 
If you delete a field, that field will be removed from (will no 
longer print in) stored records and the data that used to be 
stored in the field will be lost. 

Rewriting the data file 

To hold temporary files, Form Finisher requires additional free 
space on your disk equal to the size of your data or definition 
file, whichever is largest. This is because Form Finisher writes 
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your new, changed file to the disk before deleting the old file to 
protect your data against loss due to disk errors during the write . 

procedure. 

Form Finisher rewrites your data file whenever you: 

Add fields 
Change the cpi 
Delete fields 
Compress data 
Change a field's width 

Form Finisher will change the form definition file, but will not 
rewrite the data file when you: 

Change the prompt order 
Move a field 
Make a field calculated or not 
Change ruler scales 
Change the calculation 
Change form size 
Change printer adjustments 
Change the print height (lpi) 
Change printer types 
Change database access 
Make an existing field a date field (and vice versa) 
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4 - 
Save and print the form 

definition 

Run a test print 

Once you have entered a couple of fields on your form, we 
recommend that you print a test form to ensure that your 
spacing and alignment are correct. The P r i n t  test form com- 
mand prints a record in which every field is filled with x's. 

To run a test print, put a copy of your preprinted form (or a 
blank sheet of paper) in the printer. Choose P r i n t  tes t  f orm 
from the Files menu. If you don't like the result, you can adjust 
the scale, remeasure, and adjust field locations as you learned in 
Chapter 3. 

Save as... 

To save your new form definition, choose Save as .  . . from the 
File menu. A dialog box prompts you for a filename in which to 
save the new form. Enter the name and press El or click on the 
Save button. 

When you save a form, the form's definition and related data are 
actually saved to three separate files. Each has your form's 
filename followed by an extension: .FFD, .FFA, or .DBF. These 
files are described as follows: 

PIFD: This file stores the form definition, including full field 
names and calculations. 

~ ~ ~ ~ _ _  ~ ~ _ _  
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JFA: This files stores database access information. Form Fin- 
isher only creates this type of file when you define a 
database access (explained in Chapter 71, so not all forms 
will have this file. 

.DBF This is the data file, which is created when you save one 
or more records. Along with all the records, Form Finisher 
stores a lkharacter (all capital letters) abbreviated field 
name for each field in this file. These short names are 
needed by dBASE-compatible programs to read Form 
Finisher data. 

When you open a form, you only need to type the name you 
gave the form file, not the extension. 

When you save an existing form, you may or may not want to 
save the associated data records with it. Choose Save as .  . . 
from the Files menu. Type the new form name at the prompt and 
select Save. When prompted, select Yes to save data records 
with the form; select N o  to save the form o&. 

Save with or 
without data 

Additional Hint If your file is getting full, save the form definition under a new 
name but don’t save the data. Your old files will remain intact 
and a new file is started to save new records. 

Save 

Any time you make changes to an existing form definition, 
choose Save from the file menu to save the changes to the file.If 
you have revised the form, Form Finisher will probably rewrite 
your data file. Because you may not want to change old records, 
Form Finisher will check whether it will have to rewrite your 
data file before saving your files, and will give you the option 
via a dialog box whether or not to continue with the save. 
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Filling in a form 

Once you have defined your form, you can fill in the form data. 
The input data used to fill in one blank form is stored in the 
form file as a record. The form description remains untouched so 
that you can use it over and over again without ever having to 
re-enter field description information. 

You have several options when filling in form data. You can: 

type in the data and print the form directly; 
save the record to a disk to print later; or 
change a previously saved record and save it as a new record. 

You can copy selected field entries, even all entries, from a 
previous form. This is a great time-saver when you're filling in a 
stack of forms that contain repetitive information. 

Select the form 

To select the form you want to fill in, choose Open. . . from 
the File menu. A dialog box like the one shown in Figure 5-1 
appears. 
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Figure 5-1 
Open File dialog box 

If you know the name of the file, enter its name in the Open 
File box. Otherwise, select it from the list in the dialog box and 
press El (or click OK). 

Once your form is displayed, choose Fi 11 i n  from the Form 
menu. Choose Begin new from the Records menu to create a 
new record of data.You can fill in form data via List View or 
Form View as described later in this chapter. 

Input Order 

When filling in the form, Form Finisher asks for field data in the 
input order that you defined when you created the form. 

When creating the form, Form Finisher automatically assigns an 
order to the fields according to the order they are defined. For 
example, it will ask you about the last field you defined last, 
regardless of where that field appears on the screen. 

To change the input order, first choose Describe from the 
Form menu. Then change the input order as follows: 

1. Change a single field’s order. 

Move the cursor to the field you want to change. Double-click 
on the field or press El to bring the Field Definition dialog 
box to the screen. Enter the new order number in the Input 
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Choose List view from the Settings menu. The List View data 
entry screen makes filling in data quick and easy by listing each 
field on a separate line in the input order you specified. See 
Figure 5-2. 

Figure 5-2 
List View data entry screen 

Order box. For example, enter a 3 if you want to make that 
field the third field you fill data into. 

order from the Fields menu Then select TOP-TO-BOTTOM. 
For example, if the fields are ordered as follows: 

-Field-& -Field-2- -Field_& 
-Field-& -Field_> -Field-& 

The new order in which Form Finisher will request input is: 
Field-1, Field-4, Field-2, Field-5, Field-3, Field-6. 

3. To order from left to right, top to bottom, choose Input 
order from the Fields menu. Select LEFT-TO-RIGHT. 

Using the example in step 2, the new input order would be: 
Field-1, Field-2, Field-3, Field-4, Field-5, Field-6. 

2. To order from top to bottom, left to right, choose Input 

The input order is especially important when you are using List 
View. If the order has not been entered carefully, you may find 
yourself entering information in what seems like a very strange 
order. 

Fill in form data using List View 
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Type the response to each field and press El or El to move the 
cursor to the next field. To leave a field blank, press Q when 
you’re prompted for data and the cursor moves to the next field. 

If you make a mistake while filling in data, move to the field 
containing the error and retype the correct information. From 
the keyboard, press the aD+B or (tl keys to move to previous 
fields; press Ed to move to the next field. 

Fill in form data using Form View 

Choose ~ o r m  view from the Settings menu. The fields display 
on the screen as they will print on your form, with the first input 
field highlighted. Type your data into the field and press El. 
The next field in the specified prompt order is highlighted. If 
you want to leave a field blank, simply press El when you are 
prompted for data and the cursor moves to the next field. If you 
make a mistake while filling in data, move back to the field and 
retype the correct information. 

Restore contents 

If you accidently cleared data from a field or overwrote c o m t  
information, before moving to another field, choose Restore 
contents from the Fields menu. This replaces the current con- 
tents with what was there before you began editing the field. If 
you have already moved to another field, you will have to 
retype the data in the field. 

Display field definition 

To display a field’s definition while in Fill in mode, move to the 
field and then choose Display definition from the Fields 
menu. To change the definition, first change to Describe mode. 

Duplicate recent record 

This command copies the field data fmm the last record you 
looked at into the selected field in the current record. Move your 
cursor to the field you want to fill, then choose Duplicate 
recent record the Fields menu. 
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First 

Next 

Previous 

Working with records 

Each time you fill out a form and save the data, the data is saved 
to its own record within the form file. Every time you open a 
form file, all records created with that form are available. Use 
the Records menu commands to search for specific records 
within the list, and to save, delete, copy, and print the records. 

Begin a new record 

To begin a new record of data, choose Begin new from the 
Records menu. (You must be in the Fill in form mode.) ”New” 
appears in the bottom left corner of your screen. New records 
have no position in the’file until they are saved. 

Find old records 

You can use the old records to create new forms in several ways. 
First, you must find the record you want to edit. 

Under the Records menu, Form Finisher provides the “find” 
commands and their respective accelerator keys. The following 
paragraphs describe how to use these commands to find records 
in your file. 

Go to the first record in the file @tEi). This command is 
greyed out if you’re on the first record or if there are no records. 

Go to the next record in the file @&€El). This command is 
greyed if you’re at the last record or if you’re working with a 
new record. 

Go to the previous record in the file in numeric order (lctll+El). 
This is greyed if you’re at the first record or if you’re at a new 
record. 
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Last Go to the last record in the file acnl+EI). This is greyed if you’re 
at the last record. 

Most recent Return to the record you were looking at before you starting 
working on the currently displayed record ( I c n a ) .  

Search To look for a specific record within a file: 

1. Choose S e a r c h .  . . from the Records menu. 

2. Select a Key field from the list and press El. The key field is 
the field that contains the information you will use for your 
search, such as ”Last-Name” or “ZIP-Code”. 

3. Enter the specific search value, such as a specific last name 
(Jones) or ZIP Code (95128), and press El. 

4. A Matching Record screen displays the first few fields of the 
first record that matches the search parameters. If more than 
one record was found, choose NEXT RECORD and PREVIOUS 
RECORD to locate the correct one. 

5. Select OK to display the record on the screen in Fill in mode so 
you can edit or copy information from the record. 

Save a record 

To save the currently displayed record as a new record, choose 
S a v e  from the Records menu. If you were editing an old record, 
the old record is left in the file unchanged. If you want to save 
the changes to the old record, choose O v e r w r i t e ,  explained 
next. 

important To hold temporary files, Form Finisher requires additional free 
space on your disk equal to the size of your data or definition 
file, whichever is largest. Form Finisher will not save a new 
record if doing so will bring the file over the limit. 

Form Finisher will warn you when it is saving the last record 
that will fit on the disk. See ”Error messages” in the Appendix to 
learn how to make more space available. 
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Overwrite 

To save new changes to an old record, choose O v e r w r i t e  from 
the Records menu. Form Finisher overwrites the changes to the 
old form. (This option is only available if you are editing a saved 
record.) 

Copy a record 

Choose copy from the Records menu to make a copy of the 
record and put it at the end of the form file. The copied record 
remains selected so you can begin editing it. 

Delete record 

Choose D e l e t e  from the Records menu to remove a record 
permanently from the file. You can only delete the currently 
displayed record. See "Compress data" at the end of this chapter 
to learn how to recover the space created by deleted records. 

Print records 

You have two choices when you go to print a record: Print record 
or Print range. Make sure that your printer setup commands 
have been properly selected. (See the "Installation" section in the 
Appendix if you are not sure.) Then, use the following steps to 
print the form. 

1. Insert your preprinted form into the printer. Make sure that 

2. Select the desired print command from the File menu. 

the alignment is correct. 

Print a record This option is only available in Fill in mode. To print the cur- 
rently displayed record, choose P r i n t  record from the File 
menu. Form Finisher will ask you to confirm that your printer is 
on and ready to print before it prints the record. 
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Print range To print a range of records in the selected form file, choose 
P r in t  range from the File menu. By default this command will 
print all the records in the file, but you can specify a starting and 
ending record. Form Finisher prints all the records in the range, 
including the starting and ending record. 

Pause between pages 

When you choose p r in t  range, Form Finisher asks if you need 
to pause between pages. 

Compress data 

Choose Compress data from the File menu when you want to 
rewrite the file to recover file space made available by deleted 
records. This option is only available (non-grey) when records 
have been deleted and the file can be compressed. 
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Calculations and databases 

Use Form Finisher's advanced features to enter calculations and 
access data stored in other databases. 

Enter calculations 

If you have fields on your form that come to a total, it might be 
very handy to have the fields total by themselves. Form Finisher 
lets you add (+), subtract (-), multiply (9, or divide(/) field 
values in up to 25 fields. You can also use matched parentheses 
in the normal algebraic manner. 

To enter a calculation into a field during form description, 
doubleclick on the field, or move the cursor onto the field and 
press m. The Field Definition dialog box appears. Use the fol- 
lowing steps to enter the calculation. 

1. Press the DEFINE CALC button. The Calculation dialog box 
appears. The name of the field being calculated appears in the 
box at the top right of the dialog box. 

box. Doubleclick on the first field in the calculation or move 
the cursor to the name and press El. The field name appears 
in the Calculation box. You can also type the field name 
directly into this box. 

3. Click on an operator (+, -, +, or /) or enter the operator from 
the keyboard. Then choose the second field in the calculation, 
and so on. 

For example, your calculation in a field named "Total" may 
look like the following: Invoice-Amt + Past-Due. 

2. All your field names are listed on the left side of the dialog 

4. Select OK when you finish entering the calculation. 

The Field Definition dialog box reappears on the screen, with 
your formula shown in the Calculation box at the bottom 
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of the screen. You cannot edit the calculation in this dialog 
box. To make changes to the calculation, select the D E F I N E  
CALC command. Then edit the data in the Calculation dialog 
box. 

Calculate The fields do not calculate until you choose C a l c u l a t e  from 
the Fields menu or press Icnl4El. 

Ca Icu I at in g Money 

In most mathematical circumstances, it's best to compute to the 
greatest degree of precision possible. However, in financial 
computation, numbers are often rounded to the nearest penny 
or even to the nearest dollar. 

Form Finisher uses numbers as they appear on the form and 
uses decimal places only for calculated values. If you enter 2.775, 
but you have only specified two decimal places (in the Field 
Definition dialog box), the number will appear as you entered it: 
2.775. However, if the calculation value for a field with only two 
decimals is 2.775, it will appear in the field as 2.78. 

Rounding vs. 
Truncating 

Many types of money calculations require you to "round or to 
"truncate" values. Note that when you "round" you can make 
the number bigger or smaller. For example, $1.10 is closer to 
$1.00 than to $2.00, so it would round down to $1.00. On the 
other hand, $1.51, and $1.90 are closer to $2.00 so they get 
rounded up to $2.00. By convention, $1.50 is also rounded up. 

Truncating refers to ignoring any fractional amounts after a 
designated value. For example, if you convert $1.99 into simple 
dollars by rounding, you get $2.00. If you truncate the amount, 
you get $1.00. The other 99u is fractional and is just discarded. 

Form Finisher rounds. If you want to truncate in your calcula- 
tion, here's a handy method: subtract 1/2 of the smallest unit 
and let Form Finisher round the results. This will give you the 
same result as you'd get by truncating the number. For example, 
if you are calculating to the nearest whole penny, subtract half a 
cent. 

Override calculations Form Finisher only calculates when you ask it to (by pressing 
@+O or by choosing C a l c u l a t e  from the Fields menu). So, 
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Note 

Boilerplate fields 

you can replace a calculated result with something else (like "No 
charge" on a billing amount) using the following steps. 

1. Press larl+o to calculate the form. 

2. Move to the field you want to overwrite and enter the infor- 
mation (text or number) into the field. (Enter a space if you 
want to leave the field blank.) 

If you choose C a l c u l a t e  again while working on this record, 
Form Finisher will replace all values in calculated fields with 
freshly calculated values. 

Boilerplate fields are those that contain data that does not 
change. For example, your company name may always print in 
the same place on a particular form. So that you don't have to 
type in the information on each record, Form Finisher allows 
you to designate a field that contains non-changing information. 

1. select DEFINE CALC in the Field Definition dialog box. 

2. In the calculation box, type a leading quote ("1 and then type 
your boilerplate text. For example, to enter XYZ Corporation 
as boilerplate text, type the following in the space provided: 
"XYZ C o r p o r a t i o n  

3. Select OK to save the calculation. 

4. Like any calculation, you must press larl+o during form fill- 
in to display the boilerplate text in the field. 

Read data from other databases 

In addition to having access to information stored in old records, 
you can also look at information stored in the following data- 
bases without exiting Form Finisher: 

DeskMate Address Book 
Tandy Filer 
dBase I11 Plus and dBase IV 
Form Finishefs data files for other forms 

Tell Form Finisher to automatically access the desired informa- 
tion in up to five database files. Form Finisher prompts you to 
choose whether or not to copy the information into your form. 
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New database 
access 

Use the following steps to define a new database access. 

1. Choose the form. Open the form’s description, or create a 
new form. You can define a database access on any saved 
form containing at least two fields. Then select N e w  
database. . . from the File menu. 

2. Choose a ”key” field. The key field is the field Form Finisher 
uses to find the right record in another database. When you 
enter information into the key field, Form Finisher immedi- 
ately searches for records in the other database file(s) that 
contain the same information as your key field. 

For example, suppose you’re filling out invoices and want to 
look up a customer‘s address in DeskMate’s Address Book. 
Use the customer‘s last name as the key field. See Figure 7-1. 
As soon as you enter the name (Smith) into the INVOICE 
form, Form Finisher will check the Address Book for the 
addresses of people named Smith. 

Figure 7-1 
Choosing a key field 

To select the key field, scroll through the list of field names to 
highlight the correct one. Press El to select the field. 

Once you’ve selected the key field, the Match Fields dialog 
box is displayed so you can complete your database defini- 
tion. 

3. Name the database. Enter the name of the database you wish 
to access, such as DeskMate’s Address Book file 
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Figure 7-2 
Matching fields 

PERSONAL.ADR (as shown in Figure 7-2), a DeskMate Filer 
data file, or a dBASE format (.DBF) data file. Press El. 
Form Finisher lists the database file's fieldnames in Data- 
base  F ie lds .  The INVOICE form's fieldnames are listed in 
Form F i n i s h e r  Fields. 

4. Find a field in the database to match against your key. Your 
form only contains one key field, and you must identify a 
matching field for the key field in each database you access. 
Using our example, you want to find addresses in the Ad- 
dress Book for people who have the same last name as the 
one you will enter in the key field when you're filling in the 
INVOICE form. You must tell Form Finisher which Address 
Book field holds the last name. 

In the FormFinisher  F i e l d s  box, highlight Last-Name 
and press EZI. Scroll through the list in the Database Fields list 
to highlight LastName, the field in which the Address Book 
stores last names. Press Q to move the cursor to the MATCH 
button, and press [-J to select it. Form Finisher lists the 
pair of fields in the Matched Fields box below and notes 
that these are the matching "key" fields. 

5. Find matches for fields that you want to fill with data. 
When Form Finisher finds the database record you're looking 
for, it will copy information from that record into your 
current form. You have to tell Form Finisher which fields in 
the INVOICE form should receive data, and which Address 
Book fields the data should come from. 
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Using our example, to enter a person’s name and have Form 
Finisher fill in their address, you’ll need to match any fields in 
your form that contain address data (such as S t r e e t  and 
C i t y )  with similar fields in the Address Book. As shown in 
Figure 7-2, you would match the INVOICE form’s S t r e e t  
field with the Address Book‘s A d d r e s s  field. Highlight both 
fields and press CZl, then 

6. Delete mistaken matches. To delete a match, highlight it in 
the Matched Fields list and select DELETE MATCH. 

7. Name the next database. Form Finisher retrieves data from 
up to five database files at the same time. To identify the next 
database, select NEXT. To look back at the definitions in the 
first database, select PREVIOUS. 

8. Save your matches. Once all matches are selected, select OK. 
Now when you enter a last name (like Smith) into the IN- 
VOICE form, Form Finisher will look up the first address of a 
person named Smith, and will ask you if it’s the record for 
Smith that you want to use in your form. If you say yes, the 
record’s street address and city is copied into your invoice. 
Select CANCEL at this time to exit this dialog box without 
saving the matches you entered. 

to select MATCH. 

Fill in the form Once you’ve created an association between your form and the 
source database, whenever you fill in the form-as soon as you 
enter information into the key field-Form Finisher looks up the 
information in each file. 

Before writing data onto your form, Form Finisher displays the 
information it has found (see Figure 7-3). Select NEXT RECORD to 
find another record that matches the key field in your form. 
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Figure 7-3 
'Data From" screen 

First-Name: Robert 
Street: 11221 Plumncr I.ane 

C i t y :  Plunncr City !I 

Additional Hints When Form Finisher shows you the information it has found, it 
only shows the fields in the "found" record that match the fields 
you said you want to fill in your form. If more than one record 
might contain the key field's data (in our example, Smith), you 
have to provide yourself a way to tell one record from another. 
For example, you may want to additionally match the 
First-Name field in the invoice with the FirstName field in the 
Address Book so that you'll be able to see Smith's first name. 
This can be especially helpful if you are using more than one 
database to access records. 

Suppose you looked up the wrong address-perhaps someone's 
home address instead of their work address. You can ask Form 
Finisher to look up an address again as follows: First, move the 
cursor out of this field, into another field. Then move the cursor 
back into the key field and re-enter the field's value (the person's 
name). Form Finisher will look up the data again, just as if you 
were entering the name for the first time. 

Finally, when you read dates from Address Book and dBASE 
files, be prepared for odd-looking results sometimes. Form 
Finisher saves and reads dates as text strings - if you enter 
"09/08/89", that's exactly what it saves. Filer files work the same 
way, and many dBASE users save their dates in text fields. Form 
Finisher reads these dates with no problem. However, Form 
Finisher does not translate dates from Address Book's and 
dBASE's (mutually exclusive) special date formats. 
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Modify database 
access 

At any time while working on your form in Describe mode you 
can redefine your database access fields by choosing Modify 
database. . . from the File menu. You will receive the same 
prompts and dialog boxes as you saw when you defined your 
new database access. 
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Appendix 

Hard disk 
installation 

Notes 

Installation 

Form Finisher requires 512K of RAM. It will also work on a 384K 
Tandy loo0 TL or SL when you run under the ROM version of 
DeskMate, and can run under any version of the DOS operating 
system version 2.11 or higher. You can use Form Finisher with 
or without a mouse. 

There are two procedures for copying Form Finisher onto your 
hard drive. If you have DeskMate version 03.02 (1988) or 03.03 
(1989), follow the Standard DeskMate installation instructions. If 
you are not using either of these DeskMate versions, follow the 
Runtime DeskMate installation instructions. 

Standard DeskMate installation instructions. 

1. Start DeskMate. 

2. Insert the Form Finisher Program disk into drive A. 

3. Choose Install from the Desktop menu E l ) .  
4. When the Display Menu dialog appears, choose a style of 

window to display Form Finisher files in by pressing the 
button beside the window style. 

5. Select OK or press El to close the dialog box. An outline of 
the new window, titled “FORMFINISH,” appears on the 
Desktop. Press El to confirm the position of the window. 

INSTALL creates a FORMFINISH window on your Desktop. If 
you already have a FORMFINISH window, or if FORMFINISH is 
listed in your Desktop as an available window, INSTALL may 
tell you there’s no new application to install. This situation is 
most likely to arise if you start installing Form Finisher and 
don’t finish for some reason. In this case, pull down the Desktop 
menu m), and delete the existing FORMFINISH window. Then 
run INSTALL again. 
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If there’s not enough room on your hard disk for INSTALL to 
copy Form Finisher‘s files, INSTALL returns to DeskMate 
without copying the files. If no FORMFINISH window appears, 
or if it appears but the AIRBORNE.FFD, EXPRESS.FFD, and 
FEDEX.FFD files aren’t included, you will have to make more 
room on your hard disk before using Form Finisher by erasing 
unnecessary files. Then, return to DeskMate, delete the existing 
FORMFINISH window from the Desktop, and try INSTALL 
again. 

Runtime DeskMate installation instructions. 

1. Type C : (or the correct hard disk drive) and press El. 

2. Type MD \FF and press GI. (It‘s okay to use something other 

3. Type CD \FF and press D. 

4. Insert the 3.5” program disk, or either 5.25” disk into drive A. 
Type COPY A: * . * and press El. 5.25” floppy disk users: 
Insert the second disk and repeat this step. 

than ”FF” as a directory name.) 

Floppy disk users The 3.5” Form Finisher Program disk contains the same files as 
the two 5.25” disks. If you don’t have a hard disk, use the DOS 
DISKCOPY command to make a working copy of the floppy 
disk (or disks), and store the originals in a safe place. 

You will be concerned about disk space if you are using the 
Runtime portion of DeskMate. Runtime DeskMate gives you 
enough of DeskMate’s features to run Form Finisher, but does 
not provide you with DeskMate applications such as Address 
Book and the Filer. Follow the Runtime DeskMate installation 
instructions below. If you have DeskMate version 03.02 (1988) or 
03.03 (1989), use the following instructions. 

Standard DeskMate installation instructions. 

Start DeskMate in your usual way and run Form Finisher as you 
would any application. The only files you’ll need from the 
program disks are: FF.PDM, AIRBORNE.FFD, EXPRESS.FFD, 
and FEDEX, FFD. Copy only these files onto your DeskMate 
disk or onto a blank disk. Everything else is DeskMate Runtime, 
which you don’t need. See Chapter 1 when you’re ready to start 
the program. 

Run time DeskMa te installa tion instructions. 

To save disk space, delete the following files from the Form 
Finisher Program disk: 
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DMPDl .RES 
DME’D2. RES 
INSTALL. PDM 
FFFILES .DAT 

Printer driver for unsupported printer 
Printer driver for unsupported printer 
For hard disk users 
For hard disk users 

In addition, delete all of the video drivers except the one you’ll 
be using. The drivers are as follows: 

DMVS 10 0 0 . RES 
DMVSTC16. RES 

DMVSCGA .RES For CGA graphics 
DMvSEGA . RES For EGA graphics 
DMvSVGA . RES For VGA graphics 
DMVSMCGA . RES 
DMVSHERC .RES 

For Tandy loo0 4color (and monochrome) 
For Tandy 10oO 16-color (on the Runtime 
disk) 

For MCGA graphics 
For Hercules monochrome graphics 

If you aren’t sure which video driver you use, here’s a way to 
find the correct driver. 

1. Rename the video driver files with .XXX extensions. 

2. Start Form Finisher by inserting the program disk in drive A 
and typing FF and pressing a. DeskMate will ask for files as 
it needs them and you should swap disks as needed. Desk- 
Mate will eventually ask for-by n a m e t h e  video driver you 
need. Press (kl to return to DOS. 

3. Rename the desired video driver file’s extension back to .RES. 
Then delete the other video driver files. 

Additional Hint You might find it handy to copy the COMMAND. COM file from the 
disk you start your computer with onto your Form Finisher 
disk. 

Installing your 
mouse driver 

If you are using a mouse and your mouse is not fully compatible 
with the Microsoft@ serial mouse, you must run your mouse 
driver (provided by the mouse manufacturer) to make your 
mouse emulate a Microsoft serial mouse. Do this before you start 
Form Finisher. Mouse setup is provided through the F10 menu. 

Set up the printer 

Supported printers Form Finisher works with any printer that accepts the Epson/ 
IBM command set. It has been tested on the following printers: 
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Tandy DMP (dot matrix) Models 106,107,132,430,440, and 2120 

IBM Proprinter XL 

Epson MX, FX, and FX 
Tandy LP loo0 (laser printer) 

Tandy DWP 230 (daisy wheel printer) 

Specify printer If it has not already been done through DeskMate, or if you 
regularly use more than one printer, you may need to tell Form 
Finisher what printer you are using. 

1. Press IFD]. 

2. Choose Setup from the F10 menu. 

3. Refer to the following instructions to set up your printer. 

Tandy dot matrix printer 

1. Set the printer into IBM mode, IBM character set 2, with the 
line feed after CR dip switch OFF. (This is the normal setting 
for IBM printer emulation.) 

2. Select IBM Graphics P r i n t e r  in the Setup Printer dialog 
box. 

3. In Form Finisher's Scaling dialog box (under the Settings 
menu), leave the Dot Matrix Printer set to P r o p r i n t e r  
compat ible. 

IBM Printers and Proprinter compatibles 

1. Select IBM Graphics P r i n t e r  in the Setup Printer dialog 

2. In Form Finisher's Scaling dialog box, leave the Dot Matrix 

box. 

printer setting at P r o p r i n t e r  compatible.  

Epson dot matrix printers and compatibles 

1. Select IBM Graphics P r i n t e r  in the Setup printer dialog 

2. In the Scaling dialog box, select Epson compatible .  

Some Epson printers can emulate the Proprinter and should be 
set to Proprinter compatible. If you aren't sure, print a grid at 12 
cpi. If Form Finisher prints 12 characters per inch, you have the 
correct printer setting. If not (if Form Finisher tries to print a 
grid that's wider than your page), select the other dot matrix 
printer type (Proprinter or Epson). 

box. 
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Other printers 

LPlOOO laser printers use the following settings: 

IBM Proprinter Emulation 6 LPI 
Portrait, Normal WP) Mode 
CR=CR, LF=LF, FF=FF+CR USA 
Auto Wrap Disabled Printable Area 
IBM Char Set 2 

Letter Gothic 10 

If your printer isn’t compatible with Epson or IBM printers, you 
can still use Form Finisher, but you can probably only print at 
one character width (10 cpi) and one line height (6 lpi) 

Many printers are partially compatible with Epson or IBM 
printers. Try the IBM Graphics Printer option in the Setup 
Printer dialog box and both settings (Proprinter and Epson) in 
the Scaling dialog box. Also, try the ”ASCII” printer driver, 
which sends out printer control codes common to many daisy- 
wheel printers by selecting ASCII in the Setup Printer dialog 
box. 

Daisywheel printers 

Form Finisher supports the Tandy 230 Daisywheel Printer, and 
many others that have control code sets that match the 230’s. 
Choose Tandy Daisywheel or IBM Daisywheel in the Setup 
Printer dialog box. 

If your printer double-spaces, switch from the IBM setting to the 
Tandy. If it prints everything on one line, switch from Tandy 
Daisywheel to IBM. 

Note Form Finisher supports 10 and 12 cpi and compressed print, at 6 
and 8 lpi. It supports built-in fonts (Courier) only. To use other 
fonts, select Custom in the Scaling dialog box after setting up 
your printer outside of Form Finisher. Form Finisher will not 
reset your printer, so it will print in whatever font and size you 
have selected. 

Using a mouse 

Just click the mouse at the place on the screen where you want 
to move the cursor. The cursor appears in the new position. 
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Even though you are using a mouse, you may still want to take 
advantage of some of the accelerator keys on the keyboard. See 
the Keyboard quick reference card included in this manual. 

Choosing menu 
items 

To choose menu items: 

1. Move the mouse pointer to the menu title. Click and hold the 
mouse button to display all the available menu commands. 

2. Drag the mouse pointer down the menu commands to 
highlight the one you want to choose. 

3. When the command you want is highlighted (shown in 
reverse video), release the mouse button. The command is 
activated . 

Selecting dialog 
box options 

Use the mouse button to click on dialog box options, such as 
input boxes and buttons. When you click on a button, it appears 
shaded when selected and unshaded when unselected. 

Click OK to save changes selected in the dialog box or CANCEL to 
ignore changes. 

Error messages 

The following list identifies possible error messages in alpha- 
betical order, followed by a reason for the message and ideas on 
how to solve the problem. If after trying our suggestions you 
still need help, call the Power Up Product Support Group at 
(415) 345-0551. 

<Field-Name> now overlaps another field. Reposi- 
tion or change settings 
This message appears when you try to rescale a form to fewer 
characters or lines per inch. The field named in the message is 
beside or just above or below another field. Form Finisher 
cannot convert to the new scale without overlapping the two 
fields, so it will not accept the new scale. Move the fields further 
apart or enter slightly higher cpi and lpi values. 

<Field-Name> is missing. Check your diskette 
You probably changed disks at an unexpected time, before (or 
while) saving or reading a record or file. 

A match must be selected between the key field 
and one of the database fields 
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While defining a database access, you selected OK (or pressed 
in the second dialog before saying which database field corre- 
sponds to the key field in your form. 

A match must be selected for the key f i e l d  and 
a t  l eas t  one other f i e l d  
While defining a database access, you selected OK (or pressed 
El) in the second dialog before identifymg at least one database 
field that will provide data to a field in your form. 

A search value must be specif ied 
When asking Form Finisher to search for a record, you must tell 
it the field and value to search for. 

A l l  fields are above the current vertical 
printer off  set 
The "vertical printer offset" is the number of "rows/inches 
down", in the Printer adjustments part of the Set Scaling dialog. 
If you set your offset to 5" down, you're telling Form Finisher 
that the printer will start printing 5" from the top of the form. 
Form Finisher won't print anything that should be printed 
higher on the form because your printer adjustment means that 
the printer can't reach higher places on the form. If all your fields 
are above this offset, Form Finisher will give you this message, 
and won't print. To print these fields, change your printer 
adjustment setting and reposition your form in the printer. 

Allowable values for characters and l ines  per 
inch are from 5 . 0  t o  25 .0  
You have entered a character width or line spacing value in the 
Set Scaling dialog that is outside of Form Finisher's limits. Form 
Finisher supports any character width or line spacing value be- 
tween 5 and 25, if your printer supports that size, 

Allowable values for printer o f f se t s  are from 
0 . 0  t o  6 . 0  inches (or equivalent i n  columns) 
You have entered a printer adjustment value that is outside of 
Form Finisher's 1imits.You must specify a positive value for how 
far down and how far to the right your printer begins printing 
on a page and the distances must be less than 6 inches or the 
equivalent in columns (for example, 72 columns in 12 cpi). 

A t  l eas t  one database must be named 
While defining a database access, you selected OK (or pressed 
El) in the second dialog box before naming a database. To 
cancel this dialog, press El. Otherwise, you must say where the 
data will come from. 

~ ~ ~ 
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Attenpted w r i t e  operation fa i led .  The disk is  
w r i t e  protected. 
You are attempting to save or update a record or file located on a 
disk that is write protected. Unprotect the disk (see your com- 
puter manual for instructions), or use a different disk. 

Bad f i e l d  name or missing operator 
You have entered a formula in the Define Calculation dialog that 
is not accepted by Form Finisher. If you are entering a boiler- 
plate field, the first character in the calculation must be a quote 
("1. For other calculation fields, Form Finisher only accepts 
numbers, parentheses, field names, and the four basic operators 
(+, -, *, and /I. Form Finisher reads calculations that use these 
operators ("Field + Y), not lists such as "1,2,3." The most 
common error flagged by this message is a missing underscore 
in a field name (you typed "Field Name" instead of 
"Field-Name" ). 

Bad Number 
Form Finisher cannot use this number in a calculation. For 
example, it can't use 1.2.3.4.5. 

Cancel access t o  database: <FILENAME> (Y/N) 

You deleted a filename from the Database edit box (the second 
step of database access). Type Y to tell Form Finisher that you 
want to cancel this form's access to that file. 

Cannot end with operator 
When defining a calculated field, you cannot end the formula 
with an operator (+, -, *, /). Acceptable formula endings include 
numbers, parentheses, field names. 

Cannot load DeskMate database resource. Form 
Finisher w i l l  run with database access not 
available. 
You are probably trying to run Form Finisher without enough 
free memory. Form Finisher will run with all other features 
intact, but cannot read data from Tandy Address Book or Filer. 
You can still read .DBF files, including data stored in all of Form 
Finisher's record files. 
If your computer has at least 512K RAM, or if you have a 384K 
Tandy lo00 TL or SL, you should be able to run the complete 
Form Finisher program. If this message appears and you need 
database access, find out what else uses memory on your 
machine and make the necessary adjustments. For example, 
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T d n a t e  and Stay Resident (TSR) programs, or large memory 
allocations in the CONFIG.SYS file for buffers and files. 
Alternatively, DeskMate may not be able to find its database 
resource program. It will name the file it can't find.You can find 
the resource file on your original DeskMate disk(s). 
Decimal places must be between 0 and 9 
The Decimal places field in the Field Definition dialog box 
requires a number between 0 and 9 (not a blank or a dash). 

Do you wish t o  save t h e  current  data record8 
under t h e  new f i le  name? 
When you save a file under a new name, you can either save the 
definition with the existing records, or you can save only the 
definition, under which only new records will be stored. 

E d i t  t he  f i l e  designation below t o  show t h e  
COMPLETE path, including d r ive  letter and f i l e -  
name, where you w i s h  t o  save your files 
If you are unable to save a file to a full disk and you need to 
switch drives, enter the complete datapath in this message. 

Field names must begin with a letter and contain 
only letters, d i g i t s ,  and underlines 
The most common error flagged by this message is a missing 
underscore in the field name (you typed "Field Name" instead 
of "Field-Name"). Enter the correct information in the Field 
Name field in the Field Definition dialog box. 

Field w i d t h  exceeds the  maximum of 254 charac- 
ters and/or 17 inches 
Enter the correct value in the Inches wide field in the Field 
Definition dialog box. 

Field(s) would not f i t  a t  the  indicated locat ion 
The field($ you are entering or moving will overlap with 
another field or run off the end of the form using the given 
location values. Change the row, column, or width information 
in the Field Definition dialog box. 

Fields  must be a t  l e a s t  one cohmn wide 
Enter a value between 1 and 254 columns (or the equivalent in 
inches) in Inches/Columns Wide in the Field Definition dialog 
box. 
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File already exists, overwrite? 
You are trying to save a file under a filename that already exists. 
Use a different filename to save the file. 

File or directory not found 
Form Finisher cannot locate the specified file or directory. Try a 
different file or directory name. 

Five databases already selected. To remove a 
database, delete its name in the edit box. 
You can only read data into your form from five database files, 
and you’ve already defined access to five files. 

Form Finisher must switch to form view so that 
you can indicate the Paste position 
Switch to form view, and point to where you want to paste the 
fields. 

Illegal character 
Calculation formulas can only contain field names, parentheses, 
arithmetic operators (+, -, *, and A, and a leading quote in 
boilerplate fields. At least one of the characters in your formula 
doesn’t fit these criteria. 

Illegal right paren 
Form Finisher has detected one more right parenthesis than left 
parentheses in your calculation formula. Check your formula for 
errors. 

Insufficient disk space-DBF file cannot be 
packed 
When Form Finisher compresses (packs) a file, it writes a new 
copy that doesn’t contain all of the deleted records before it 
erases the old file (so you don’t lose data in case of power failure 
or disk error during the copy procedure). If Form Finisher 
determines that it can’t fit the compressed and uncompressed 
files on the disk at the same time, Form Finisher won’t compress 
the data. 
Each time you enter a record Form Finisher checks the available 
disk space to ensure that there is enough room on the disk for a 
second copy of the file. Thus, you should have enough room to 
compress data unless you copy extra files onto the disk after 
adding records. In that case, try removing the extra files from 
the disk until after you compress the data. 
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Insufficient d i s k  space-no more records can be 
saved 
1. This message warns you after savinv a record, that it won’t 

2. When you change to fill in mode, this message warns that 

In either case, Form Finisher will not accept the addition of 
another record. If you think you have enough room on the disk, 
remember that Form Finisher requires enough free space on the 
disk to make a second copy of the data file (or the form defini- 
tion file-whichever is larger). 

have room to save another record on the disk. 

there is not enough room for another record. 

Insufficient d i s k  space-record cannot be saved 
If you ignored Form Finisher‘s warning about limited disk space 
and tried to enter a new record, the record cannot be saved. To 
make more room on the disk, delete unnecessary records and 
compress the file, or delete unnecessary files from the disk. 

Invalid extension or file not found: <filename> 
When you enter a filename in the Database edit box (the second 
step of database access), Form Finisher checks the disk for the 
file. If your file is on a different drive, include the path when 
you enter the filename. 

Invalid handle, invalid path 
DeskMate is trying to save a file in an impossible place. Try 
going to the Save As dialog box and specifying the full datapath 
(drive and subdirectories) for this file. 

Item would exceed maximum length 
While defining a calculation, you selected a field whose name is 
too long to fit in the space remaining. The calculation formula 
can only be 160 characters. (In a few special cases, you can also 
get this message when trying to add an operator to a long 
calculation.) 

Negative field positions are not allowed 
You must enter positive values for a field’s starting row and 
column coordinates. 

No data obtained from <filename> 
This message appears in Fill in mode when you enter data into 
your database access key field and Form Finisher can’t find a 
matching record in the specified database. 
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No data obtained from <path and database name> 
This message appears when Form Finisher can’t find a match for 
the key field in the specified database. This message also 
appears when Form Finisher can’t find the database file in this 
directory. 

No matching records found or no record selected 
This message appears in when you are searching for a record in 
Fill in mode and Form Finisher can’t find a matching record. 

Not a Form Finisher form description ( .FFD) f i l e  
Even though the file you tried to load has the right extension 
(.FFD), it doesn’t contain a form description that Form Finisher 
can read. 

One or nuire calculations could not be pasted 
into new fields (out of space) 
You can define calculations for up to, but not more than, 25 
fields. When you paste a copy of a field onto the form, it keeps 
its original calculation. If pasting fields from the clipboard 
would result in more than 25 fields, you will get this message. 
Reduce the number of calculated fields on the clipboard or in the 
form. 

Out of disk space 
If you are trying to save a file and receive this message, try 
saving the file on a different (already formatted) disk. 

Pasting the f i e lds  now on the clipboard would 
exceed the maximum of 255 fields 
Reduce the number of fields on the clipboard. 

Pasting the fields now on the clipboard would 
exceed the maximum record width of 4000 charac- 
ters. 
A form can hold up to 255 fields and any field can be up to 254 
characters wide, but totalled across all fields you can store no 
more than 4000 characters per record. For example, if you have a 
form with 40 fields that are each 100 characters wide, you can’t 
add any more fields to it (40 x 100 = 4000). 

Pause between records? 
Indicate “yes“ if you have to manually insert a new copy of the 
form into the printer each time you print a new record. 
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Place a blank form i n  your printer, then be sure 
your printer i s  turned on and that it is i n  the 
"on line" s tate .  When the printer i s  ready, 
press the "OK" button below. 
This message appears each time you print. If you press Enter 
and then discover that your printer is not connected or not on 
line, it will take from a few seconds to a few minutes (depending 
on the printer, cable, DOS version, etc.) for the message to get 
back to Form Finisher that the printer is not available. Turning 
your printer off and on once might speed up the process. Or you 
can regain control of the machine immediately by rebooting. 

Place a formatted d i s k e t t e  i n  the drive and then 
select OK 

Replace the almost-full disk that you tried to save to with a dif- 
ferent, formatted disk. 

Please check drive (drive-letter) 
Verify that you are not trying to save to an empty drive. 

Please insert a disk containing the f i l e  
DMDB.RES into any drive 
DeskMate 03.02 uses DMDB.RES to address the Tandy Filer and 
Address Book databases. If DeskMate can't find this file, Form 
Finisher will run with all features except access to Tandy Ad- 
dress Book and Filer. You can find this file on your original 
DeskMate disk(s). 

Please insert a d i s k  containing the f i l e  
DBREAD.RES into any drive. 
DeskMate 03.03 uses DBREADXES to address the Tandy Filer 
and Address Book databases. If DeskMate can't find this file, 
Form Finisher will run with all features except access to Tandy 
Address Book and Filer. You can find this file on your original 
DeskMate disk(s). 

Position the next blank form i n  the printer and 
then press OK 

This message appears when you are pausing between records 
during a print job so that you can manually load preprinted 
forms into the printer. 

Printer i s  not ready 
Is your printer plugged in? Turned on? Set to "On Line"? Is the 
printer cable securely attached to the printer and the computer? 
If you have a Tandy printer, are you using a Tandy cable? 

~~ 
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If you are not sure, exit Form Finisher and DeskMate to DOS. 
Type DIR to display a directory listing on the screen, then press 
the Print Screen key (Shift+PrtSc on some keyboards). Did the 
printer print? 
If not, the problem is most likely in the printer, cables, or com- 
puter connection. If it does print, go back into DeskMate, choose 
Setup from the lFlol menu, and make sure that you've correctly 
identified your printer to DeskMate. 

R6000, R6001, R6002, R6003, R6009 
You should never see these messages. They're there in case 
something that we think can't go wrong somehow does go 
wrong. If one of these messages appear, please call Power Up 
Software and tell us what you were doing, what your form looks 
like, what equipment you were using, and what happened. 

Record is missing. Check your diskette. 
You probably changed disks at an unexpected time, before (or 
while) saving or reading a record or file. 

Save changes? 
After making changes to the form definition you were working 
on, you selected N e w  from the File menu. Do you want to save 
the changes you made to the form, or do you want Form Fin- 
isher to forget them? 

Save changes to form definition? 
After making changes to the form definition you were working 
on, you selected Open (to open a different form) from the File 
menu. Do you want to save the changes you made to the form, 
or do you want Form Finisher to forget them? 

The calculation for field <field-name> caused a 
divided by zero. The result will be set to 

Form Finisher could not calculate the value of this field because 
one of the divisors in the formula is 0, yielding an impossible 
result. Check your formulas. Are they correct? Does a value in 
some other field cause the zero in the divisor? Is that the right 
value?If the formula and other fields are correct, delete the *'*'s 
in the calculated field and enter the appropriate number. 

\' * * * * * * * *', 

The calculation for field <field-name> refers to 
a deleted field. The result will be set to 
* * * * * * * * 1' 
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Form Finisher could not calculate the value of this field because 
you've deleted one or more of the fields listed in its formula. 
Switch to describe mode to examine the field's definition and 
redefine the bad calculation. 

The calculation for field <field-name> was too 
large to fit in the field. The result will be 

Form Finisher could not put the calculated value in this field 
because the field is too small. Widen the field if necessary. 

set to "********" 

The calculation for field <field-name> requires 
a number in field <field-name>. The result will 

Form Finisher allows you to put a word in a field that normally 
holds a number, for example, NO Charge might be entered in a 
Total-Payable field. However, Form Finisher only knows how to 
calculate numbers, not words. Manually enter the correct value 
in this field if necessary. 

be set to n******** f ,  

The FFD file will be saved. To make a one-drive 
copy of the DBF file, use the DOS copy capmnand. 
Form Finisher is unable to copy a file from one disk to another 
on the same disk drive. Since Form Finisher keeps the form 
definition and the database access information in memory, it can 
save these files (.FFD and .FFA) onto a new disk, but it can't 
copy the data file (.DBF) from the old disk to the new one. To 
copy the .DBF file between disks, quit Form Finisher and 
DeskMate, and use the DOS copy command. 

The maximum number of 25 fields have already 
been marked 
If you want to copy or move more than 25 fields, copy the first 
25, paste them where you want them, and then mark and copy 
the rest. 

The maxbuxn form width is 17 inches or 255 
columns 
Enter a value up to 17 inches in the Form size dialog box. 

The maximum form height is 11 inches or 255 rows 
Enter a value up to 11 inches in the Form size dialog box. 

The minimum value for each form dimension is 1 
inch 
Forms narrower or shorter than one inch are not supported. 
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The program DBREAD.RZS will not fit 
The program DBUPDATE.RES will not fit 
There is not enough free memory on your machine to run Form 
Finisher complete with database support. You will not be able to 
look up data from Tandy Address Book or Filer files. 

The program DMSETUP.ACC will not fit. 
You don't have enough free memory to run Setup from within 
Form Finisher. Form Finisher prioritizes functions that it will 
drop when you run it with too little memory. Setup is the first 
function Form Finisher chops. If you're running Form Finisher 
under DeskMate, just exit Form Finisher and run Setup from the 
DeskMate desktop. If you're running the DeskMate Runtime 
version of Form Finisher, the trick is to reduce the amount of free 
memory by up to 32K. Then Form Finisher will drop database 
access (which takes more room), but will regain access to Setup. 
To do this, exit Form Finisher and run a small 
Terminate-and-Stay-Resident program, like a mouse driver or 
the DOS PRINT command. Or increase the number of FILES and 
BUFFERS in your CONFIG.SYS file (see your Dos manual). 
Now run Form Finisher again. It should tell you that it doesn't 
have enough memory to run a database program; then you can 
run Setup. After changing your printer, mouse, or color settings, 
press lbcl to exit Setup, then Ihcl out of Form Finisher. Reverse 
any changes you made to CONFIG.SYS, reboot to clear out your 
TSRs, and rerun Form Finisher. You'll again have no Setup and 
full database access. 

The requested program will not fit in the cur- 
rent system memory 
You need 512K, or 384K on a Tandy loo0 TL or SL, to run Form 
Finisher. If your machine has less memory (but enough to run 
DeskMate) DeskMate flags the problem while loading Form 
Finisher when it attempts to load the DeskMate database re- 
source (the "requested" program). 
If possible, Form Finisher will run anyway but without database 
access capabilities (you can't look up data from Tandy Address 
Book or Filer files). 
If you have enough memory to run Form Finisher, but less than 
32K left, you cannot task switch. That is, you cannot switch to 
another program (like those located under the F10 menu- 
Setup, Spell Checker, etc.) while in Form Finisher. Exit Form 
Finisher and run the programs from the DeskMate desktop. 

There is insufficient disk space to save your 
files. Your options are: Change Drives, Don't 
Save Data, Change Diskette, Cancel. 
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Select the appropriate action. 

This record has been changed. Indicate the 
action to be taken: Save, Overwrite, Don't Save, 
Cancel. 
Select the appropriate action. 

Unable to access printer 
This message most often appears when DeskMate thinks you 
have no printer. Verify that you selected a printer in the F10 
Setup dialog box. If so, verify that your printer is plugged in, 
connected properly, and set to "On Line" or "Ready." If you are 
using a Tandy printer, are you using a Tandy cable? 
Exit Form Finisher and DeskMate to DOS. Type DIR to display a 
directory on the screen. Press the Print Screen key (Shift+PrtSc 
on some keyboards). If the printer does not print, it is most likely 
a problem in the printer, cables, or computer connection. 

Unable to locate file DMDB-RES. Press Enter to 
search entire system or Esc to cancel the system 
search 
If DeskMate can't find this file, Form Finisher will still run but 
without database access capabilities (you won't be able to look 
up data stored in Tandy Address Book or Filer files). 

Unable to open association file 
DeskMate returned a disk error when Form Finisher tried to 
read a database access definition (.ITA) file. If you have a 
backup copy of the form on another disk, write protect that disk 
and then try reading the form definition from it. 

Unable to save association file 
DeskMate returned a disk error when Form Finisher tried to 
save a database access definition (.FFA) file. It would be wise to 
save the form on another disk. 

Unmatched parentheses 
You probably have one too many left parentheses in your 
calculation formula. 

Warning: field names in pasted calculations may 
need to be edited 
When you paste calculations into a form, this message warns 
you to check the field names in the calculations to verify that 
you are calculating the correct fields. 
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You have already defined the maximum of 25 
calculations 
You cannot add another calculated field. 

You have changed your form description, but your 
stored data match the old description. You 
options are: Update data, Cancel 
If you have already entered data into a form's data file, and you 
add, delete, or change the width of a field in the form definition, 
Form Finisher has to rewrite the old data to make the new 
records have the same fields (same names, same sizes) as the old 
records. Before it does this, Form Finisher verifies that this is 
what you want to do. 

Program Capabilities 

These commands have the following limitations. 

PaPeSize 
Length Max: 14 in. or 255 rows 

Min: 1 in. 
Width Max: 17 in. or 255 columns 

Min: 1 in. 
Scaling 
Inches/columns down Max: 6 in. 
Inches/rows right Max: 6 in. 
Custom character width Max: 25 cpi 

Min: 5 cpi 
Field Definition 
Field name length Max: 30 char. 
Field name Must begin with A-Z or a-z, and con- 

tain 0-9, A-Z, a-z, and the underscore 
character 
Max: 255 (up to a maximum of 4000 
char.) 
Max: Form's width x cpi 
Max: Form's length x lpi 
Max: 254 char. or the width of one 
form 
Min: 1 char. 

Number of fields 

Columns right 
Rows down 
Field width 

Define calculation 
Calculation Max: 160 char. 
Numbers 

Filename length Max: 8 char. 

Must start with a digit, not a decimal 
point 

6 8  A p p e n d i x  



Index 
10 and 12 cpi 21 

A 

Accelerator keys 5 
Activity menu 

fill in form 35 
Add fields 28 
Adjust field definitions 15 
Alignment 27 

B 
Boilerplate fields 45 

C 
Calculations 43-45,58,64 
Character width 

10 and 12 cpi 21 
compressed 22 
custom 23 
default setting 18 

Clear 29 
Clipboards 30 
Cols Wide 27 
Columns right 27 
Compress data 42 
Condensed 22 
Copy 29 

records 41 
Custom 

character width 23 
line spacing 23 

Cut 29 

D 

Database access 45,50,57,67 

Decimal places 27 
DEFINE CALC 28,57 

boilerplate fields 28 
Define fields using Form View 

2 5 .  
DELETE MATCH 48 
Delete Record 41 
Describe form mode 5 
Disk drives 

DMDB.RES 63,67 
Duplicate recent record 38 

new 46 

changing 8 

E 
Edit 

fields 28 
text 28 

Edit commands 28-29 
Enter field locations 13 
Express Mail form 7 

F 
Field definition 

adjust 15 
display 38 

Alignment 27,56 
Cols/Inches right 27 
Decimal places 27 
Define Calc 28,44 
Field Name 26 
Field type 27 
Half line down 27 
Input order 26,36 
Rows/Inches down 27 
Width 27 

Field Name 26,56 
Field Type 27 
Fields 

Field Definition dialog box 

add 30 
boilerplate 28,45 
define 25 

using Form View 25 
using List View 28 

delete 30 
edit 28 
enter locations 

using a grid 17 
using Word Guide 19 

key 46 
leaving blank 8 
locate 17 
mark 29 
move 29 

Fields menu 
add 26,28 
date 27 
display definition 38 
duplicate from recent record 

input order 36 
mark 29 
number 27 

38 

restore contents 38 
text 27 

File menu 
new database access 46 
Open ... 35 
Print grid 23 
Print range 42 
Print record 41 
Save 34 
Save as... 33 

.DBF 34 

.FFD 33 

.FFA 34 
Files menu 

New 17 
Fill in mode 5,8 
Find commands 39 
First 39 
Form 

Files 

describe 13,67 
fill in 6, 35 

using Form View 38 
using List View 37 

hints on viewing 25 
open description 6 
print 10 
revise 30 
save 34 

select 35 
test 33 

Form description 
Express Mail 7 

Form length 
default setting 18 

Form size 13,65 
Form View 24 
Form width 

Forms 

without data records 34 

default setting 18 

fill in data 6 

G 
Grids 

print 12 

H 
Half line down 27 
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I 
Inches down 27 
Inches right 27 
Input order 26'36 

Field Definition dialog box 26 
Fields menu 36 
top-to-bottom 37 

Installation 51 

K .  
Key field 46 
Key fields 40 

L 
Last 40 
Line spacing 

6 lpi 20,22 
8 lpi 20,22 
custom 23 
default setting 18 

Guide 19 
Locate fields using the Word 

M 
Make printer offset adjustments 

Mark 
11 

fields 29 
text 29 

Measure the form 17 
Menus 

choosing items 
using a mouse 56 

Most recent 40 
Mouse 

driver 53 
using a 55 

Move 29 
Moving all fields at once 24 

N 
New 17 
Next 39 

0 
Open ... 35 
Overwrite 41 

P 

Pack records 42'60 
Paste 29,62 

Pause between pages 42 

Previous 39 
Print 

default setting 18 

grids 12,17,18 
line spacing 22 
range 1242 
record 10,41 
run test 15 
test form 33 

default setting 18 
character width 21 

adjustments 23,57 
offsets 11 

setup 53,63 
inches down 24 
inches right 24 
using more than one 24 

Product support 4 

Print width 

Printer 

set up 10 

0 
Quit 3 

R 
Records 6 , s  

compress 42 
delete 41 
overwrite 41 
pack 42 
print 10,41 
save 10 

Records menu 39 
calculate 43 
copy record 41 
first 39 
last 40 
most recent 40 
next 39 
overwrite 41 
previous 39 
save 10 
search 40 

Restore contents 38 
Revise the form 30 
Rewriting the data file 30 
Rows down 27 
Ruler scales 23 

default setting 18 
inches 23 
rows and columns 23 

Runtime DeskMate version 3 

S 
Save 10,34,59 
Save as 29,33 
S l e d  20 

Scaling ... 13 
Search 40 
Set Scaling dialog box 21 
Settings menu 

Form View 24,38 
List View 24'37 
Scaling 20 

T 
Text 

edit 28 
mark 29 
move 29 

sizes and spacing 20 
Type 

U 
Using a ruler 19 

W 
Word Guide 17,19 
Working on more than one 

printer 24 
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